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CCA-101: Fundamentals of IT & Programming

Assignment -1

Q1: What are the four fundamental parts of computer? Explain with the help of diagram.

Ans:

Central Processing Unit

Control Unit

Arithmetic /Logic Unit

v

Devi

The four fundamental parts of comput

1.Input Devices: Compute ny devices for input purpose. Input devices include the
mouse, input pen, touch rophone. Regardless of the type of device used, all are
components for inte tat ] communication between people and computer systems.

2. Central Processing Unit : It is the brain of the computer without this unit computer unable to

process.

The memory unit stores the binary information in the form of bits.
Q2: Discuss about the classification of computers based on size and capacity.
Ans: Based on size and capacity, computers are classified as

1) Super computers: They have thousands of processors. Because of their extraordinaryspeed,
accuracy and processing power, supercomputers are well suited for solving highly complex
problems and huge amount of calculations.

e.g. JAGUAR, ROADRUNNER etc.
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2) Mainframe computers: They are very large often filling an entire room and can process

thousands of millions of instructions per second. They are capable of supporting hundreds to
thousands of users simultaneously. Functions performed by mainframes include flight scheduling,
reservations and ticketing for an airline etc.

3) Minicomputers: They are much smaller than mainframes. They are typically larger, more
powerful and more expensivethan desktop computers. Users connect to the server through a
network by using desktop computers.

e.g. apple | pod, CDC 160A.

4) Microcomputers: They are the most frequently used type of computers. It is @lso known as
personal computers.

e.g. desktop computers, laptop.

Q3: What is the meaning of computer generation? How many computerigenerationstare defined?
What technologies were /are used?

Ans: Generation in computer terminology is a change in technologyiofya computer which were being
used

There are four computer generation such as 1% genéfation,2"? generation, 3" generation and 4™
generation.

In the first computer system, Vaccum tubes are Used:
Transistors are used in the second generation:

Integrated circuit technology were used in‘thétthird.generation.
In the fourth generation microprocessors are,used.

Q4: Differentiate between volatile and non- volatile memories.

Ans:  volatile memory non- volatile memory

1. Itis atype of computers memory that
has the capability to hold saved data
even if the power is turned off.

2. E.g. ROM, hard disk, floppy disk, etc.

3. Secondary memory provides

1. Itis a computer storage that
only maintains its data while
the device is powered.

2. E.g. RAM.

3. Primary memory has limited
storage capacity and is
volatile.

permanent storage of data and in bulk
quantity.

Q5: Distinguish among system software, application software and open software on the basis of
their features.

Ans: System software: It is a type of software that is designed to run a computer’s hardware and
applicationprograms. Software like operating systems, compilers, editors and drivers etc. come
under this category. A computer cannot function without the presence of system software.
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Application software: It is a software created for specific purpose used by end users. It can be called
an application or simply an app.

Examples: word processors, accounting app etc.

Open source software: It is a type of computer software in which source code is released under a
license in which the copyright holder grants users rights to study, change and distribute the software
to anyone and for any purpose.

E.g. the Linux operating system.

Q6: a) Create a file in MS—word to insert a paragraph about yourself and save it with file name
“yourself”. Describe all steps involved in it.

Ans: “Yourself”

My name is Wahengbam Momocha Meitei. | am 20 years old. | love toyride and sing. | am a
student of science at IMPHAL COLLEGE, IMPHAL, MANIPUR. Currentlypl am, l€arhing computer CCA
course at RGI TRAINING INSTITUTION.

The steps involved are:

» We click the Microsoft office button.

» We select new. The new document dialog box appeéass.

» We select blank document under the blank@nd receht section. | will be highlighted by
default.

We click create. A new blank documeénts appeahin the word window.

To save the document, we click again‘thesMicresoft office button.

We select save as —» word docUment. The save as dialog box appears.

We select the location whereWe want tosave the document using the drop down menu.
We enter the file “yourself” forthe dectiment.

We click the save button.

YVVVVYVY
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b)Write steps regarding followings

» To change'thefontistyle

To change the font size

To change the font color

To highlight{in yellow) the line that reads “need to get IMS’s address”.

YV V V

b) Ains: Steps to change the font style:

1. We seleat the text we want to modify.

2. left click the drop-down arrow next to the font style box on the home tab. The font style drop-
down menu appears.

3. we move cursor over the various font styles. A live preview of the font will appear in the
document.

4. |eft click the font style we want to use. The font style will change in the document.

Steps to change the font size
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1. WE select the text we want to modify.
2. Left click the drop-down arrow next to the font size box on thehome tab. The font size
drop-down menu appears.

3. We move cursor over the various font sizes. A live preview of the font size will appear on the
document.

4. 4. Left click the font size we want to use. The font size will change in the document.

Steps to change the font color

1. We select the text we want to modify.
Left click the drop-down arrows next to the font color box on the home tab. The font color
menu appears.

3. We move cursors on various font colors. A live preview of the color will appear in the
document.

4. 4. Leftclick the font color we want to use. The font color will change inthe dogument.

Steps to highlight the line

1. We select the line that reads “needs to get IMS’s address”
2. We click the highlight command and select yellow coler inthexfont group on the home tab.

Q7: Create a file in MS- Word for the following documentand'save. it with file name ‘ms-word’.
Describe all steps involved in it.

MS Word
MS Word is a widely used commercial word pracessor developed by Microsoft.
MS word is application software,Which is capable of

o0 creating;

o * aditing,

e\ savingy

e printing any type of document

Ans: MSWord
MS wierd'is a widely, used commercial word processor developed by Microsoft.

MS wierd is application software, which is capable of

e creating
e editing
e saving

e printing any type of document

The steps involved are:

1. We click the Microsoft office button.
2. We select new. The new document dialog box appears.




10.

11.

12.

13.
14.
15.
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We select blank document under the blank and recent section. It will be highlighted by
default.

We click create. A new blank document appears in the word window.

We create the given documents from the question.

We select the text “MS word” to change the font size by clicking on thefont size box on the
home tab.

We select the text “MS word” to change the font color into red by clicking on the font color
menu.

We select the text word processor and underline it by clicking the underline command in the
font group the home tab.

We select the text “MS word” to change the font style into italic by clicking itali¢@@mmand.
We select the text we want to format as a list and click on the bullets command on the home
tab.

We change the font color of the text “creating” and “saving” into blue and redyesp. by
clicking on the font color command, again we select the text “and”‘andyclick on strikethrough
command.

We select the text “printing any type of document” and change thé font style into bold by
clicking on the font style command.

We save the file name as “ms-word” by clicking the Micrasoft,officetbutton and select save as
We select the location where we want to save théidocumentusing drop-down menu

We click the save button.

Q8: Create a file in MS- word for the following déeument'and save it with file name ‘equation’.
Describe all steps involved in it.

Equations

X2 + y5=30

2’+ q*=50

ay+ b¥=x,+ y®

Ans: Equations
Xo+ Ys = 30
23+ q* =50

A2+ b8 =X2+y8

The steps are:

1.
2.

3.
4.
5.

We create the given documents in MS-word

We select the text where we want to format and click on the subscript and superscript
command on the home tab

We save the file name as “equation” by clicking the Microsoft office button and select save as
We select the location where we want to save the document using the drop down menu

We click the save button.

QQ9: Create a file in MS-Word that convert existing highlight text to table as shown below and save it
as file name ‘texttotable’. Describe all steps involved in it.

Select the text you to convert.




Select the Insert tab.

Click on Table command. A dialog box appears.

Click on Convert Text to Table, a new dialog box appears here set number of columns.

Click on OK Finally Selected text convert in a table

!

Select the text convert you want to. Select the Insert tab.

Click on Table command. A dialog box appears. Click on Convert Text to Table, a new dialog box
appears

Here set of columns. Click on OK Finally Selected text convertjin a
table

Ans: To convert existing text to table:

SN

We select the existing highlight text that we want to convert.

We select the insert tab

We click the table command

We select convert text to table from the menu. A dialeg boX appears
We click ok. Then the text appears in a table:

Q10: Create a file in MS-Word to insert a table,in the decument. Describe all steps involved in it.

Ans:

The stepSiare:

P W

o u

We place our insertion point in the document where we want our table to appear

We select the insert tab

We click the table command

We drag our mouse over the diagram squares to select the numbers of columns and rows in
the table.

Left click our mouse and the table appears in the document.

We enter the text into the table.




Q11: Create a following worksheet in MS-excel and save it with name ‘book1’.
Roll No Name Marks

1nl 60
2 n2 70
3 n3 80
4 n4 90
5 n5 40
6 n6 50
7 n7 77
8 n8 44
9 n9 88
10 n10 55
sum 654
average 65.4
maximum 90
Ans: minimum 40

Q12: Calculate the following things of a range (c2:c11) of datajin the Worksheet created in question
no 10.

- The sum of the marks using AutoSum in a range aficells(c2:c11)
- Average of the marks in a range of cells (c2:c11)

- Highest marks in a range of cells (c2:¢11)

- Minimum marks in a range of cells (c2:c11)

Roll No Name Marks

1nl 60
2 n2 70
3 n3 80
4 n4 90
5 n5 40
6 n6 50
Yol 14 77
8)n8 44
9 n9 88
10 n10 55
sum 654
average 65.4
maximum 90
ARs : minimum 40

Q13: a) Describe various steps involved in the following

- To modify column width of a worksheet
- To modify the row height of a worksheet
- Todelete rows and columns of a worksheet

Ans: - To modify column width of a worksheet:




Select a column or a range of columns.
Select a Home tab and in the Cells group, select Format.
Click on Column width and type the width for column.
Select OK.

To modify the rowheight of a worksheet.

i Select a row or a range of rows.

ii. Select a Home tab and in the Cells group, select Format.

iii. Click on Row Height And type the height for row.

iv. Select OK.

To delete rows and columns of a worksheet.

i Select the cell you want to delete within the column or row.

ii. Select Home tab. And in cells group click on Delete Sheet Column o Row.

OR
i. Select the desire row or column.

Q13 b) Describe following terms in the worksheet

Ans:

Absolute reference and relative reference in formula
Cell address

Absolute Reference:

An absolute reference in Excel means therelis a fixed peint of reference applied to a cell or a
formula. This is so the return value gwill always, stay the same no matter where the cell or

formula moves to — within the same Sheet.oracross different sheet.

This refers to a fixed point oftseference'is @' constant, and involves the use of dollar sign€ in
the formula (i.e., everyone is\to receivé the same bonus payout, so the amount €1500 is

constant in this situation).

Relative Reference:

It is the default cell reference in Excel. It is simply the combination of column name and row
number without any dollar € sign. When you copy the formula from one cell to another the
relative cell address changes depending on the relative position of column and row. C1, D2,
E4, etc. are examples of relative cell references. Relative references are used when we want
to perform a similar operation on multiple cells and the formula must change according to

the relative address of column and row.
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This refers to a relative point of reference, is constantly changing and dollar sign (€) is absent
in the formula (i.e., when each unit price and quantity are difference variables, there’s no
constant in the calculation).

- Cell Address:
A cell address is a combination of column letter and a row number that identifies a cell on a
worksheet.
For example, Al refers to the cell at the intersection of column Aand row 1; B2 refers to the
second cell in column B, and so on.
When used in formula, cell referenceshelp Excel find the values the formula should

calculate. For instance,

To pull the value of Al to another cell, you use this simple formula:

=Al

To add up the value in cells A1 and A2, you use this one:

=A1+A2

Q14.a) What tools are available to customize our PowerPoint presentation?
Ans:
Tools available to customize our PowerPoint presentation are:

a) Perspector

b) Pivot viewer

c) Autodesk 3DS Max

d) VisualBee PowerPoint Add-in
e) SmartArt

f) Animations and Transition

g) Wordle

h) CA coo

i) Oomfo

j) Clip champ

b) Write the steps fot the follewing action for the creation of power point presentation
- Open a Blank presentation
- Save the*presentation as Labl.pptx
- Adda Title to the first slide: the name of your college
-Typeyour first name and last name in the Subtitle section
- Add a New Slide which has a Title and Content
Ans:

- Toopen blankpresentation:
i Open PowerPoint presentation using ‘Run’ command (window key + R).
ii. Select the ‘Blank Presentation’. It is opened.
- Save the presentation on Lab1.pptx.:
i Select the ‘File’ on Tab bar.
ii. Click on ‘Save As’ option.
iii. Click on document/Desktop as your choice.




Machine language High level language
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iv. Type the name ‘Labl.pptx’.
V. Click the ‘Save’ button.
- Add aTitle to the first slide: the name of your college.
i Left click on the ‘Click to Add Title’ section on the first slide.
ii. Type the name of your college.
- Type your first name and last name in the subtitle section:
i Left click on the ‘Click to Add Subtitle’ section.
ii. Type your first name and last name.
- Add a New slide which has a Title and content.
i Select the Home tab.
ii. Click on the dropdown button of the ‘New Slide’ on toolbar.
iii. Select the slide having ‘Title and Content’. It is added.

Q15. Write steps for creation of a set of PowerPoint slides that demonstratesyour'skill to use'the
tools of PowerPoint. It should include the following things

» Titles slide & bullet list
Inserting Excel Sheet
Clip art and Text

Slide show effects

Y V V

Ans:

> Title slide and bullet list:

> Open PowerPoint Presentatiom:

> Select the Home tab.

> Click at the dropdown button on ‘New Slide’ at toolbar.
> Select the slide havingiTitle slidetarid Bullet list.

> Inserting Excel sheet:
i Open the slide\where you want to insert the Excel sheet.
ii. Select thegflnserttab’. Andclick on ‘Object’ on tool bar.
iii. Select the,'MichosoftiExcel Worksheet’ object type.
iv. Clickithe ‘OK button.
» Clip Art and Text:
i Selectghe Insert Tab.
i Seleet the ‘Pictures’ or ‘Online pictures’ on tool bar.
iii. Choosethe appropriate art for the topic.
iv. Click on the ‘Insert’ button.
», Slide shew effects:
i Select ‘Design Tab’ for Themes, Variants and Slide size.
ii. Select ‘Transition Tab’ for Cut, Fade, Push, Wipe, Split, Reveal, Shape, Flash, etc. for
slide effects.

Q16: What is the difference Machine language and Highlevel language?

Ans:
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1. A computer programming language 1. Itis a programming language that
consisting of binary instructions which enables development of a programin a
a computer can respond to directly much more user friendly programming
2. ltrequires no translator to translate the context
code. It is directly understood by the 2. It takes additional translation time to
computer translate the source code to machine
3. This language makes fast and efficient code
use of the computer. 3. They are programmer friendly.

Q17. Discuss about different data types of C programming Language.

Ans: The different data types in C programming language are:
Char: the most basic data type in C. It store a single character and requires a single‘hite of memory in
almost all compilers.

Int: as the name suggests, an int variable is used to store an integer.
Float: it is used to store decimal numbers.

Double: it is used to store decimal numbers (number with fleating peint value but its range of values
is high in comparison to float).

Q18.Find the output of the following expressions
a) X=20/5*%2+30-5 b) Y=30-(40/10+6)#10 €)Z=40%*2/10-2+10
Ans:a) X=33

b) Y=30
c) Z=16

Q19. Describe the syntax of the fellowing Sratements
a) If —else statement 'B)forleopgs c) white loop c) do-while loop
Ans: a) if — else statement;

If statements €an béfollowed by an optional else block of statements, which executes when the
Bootcanfexpressionfisifalse.

Syntax

If (exphession)

{

true block of statements;

}

else

{

else block of statements;




b)

d)

Q20.Find the output of th
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For loop is similar to while loop. Basic syntax of for loop is as follows:
For (expression 1;expression 2; expression 3)

{

Block of statement

}

In the above syntax

Expression 1- initializes variables.

Expression 2- conditional expression as long as this condition is true, loop will kee ecuting.
Expression 3- it is the modifier which will increase or decrease the value of the variabl

while loop

Basic syntax of while loop is as follows
While (condition)
Single statements

OR while (condition)

{

Block of statements

}

X

Do- while loop.

Do- while loop is just like a while loop except that t ndition is checked at the end of the
loop rather than the start. This has the tthatithe bady of the loop are always executed at
least once
Basic syntax of do-while loop is as follows

Do
{

Single statement
Or
Block of statements%

owing program segments

#include <stdio.h> #include <stdio.h>
Int main() Void main()
{ {
Inti=1; Int a=10, b=100;
While (1<=2) If (a>b)
{ Printf(“ Largest number is
Printf( “IMS Ghaziabad\n”); | %d\n”,a);
} else
} printf(“Largest number is
%d\n” , b);
}

Ans:a) 1







